FIRST STEPS - Digital Literacy Course

NECA Training Curriculum

DIGITAL LITERACY-FIRST STEPS

MODULE THREE – INTRODUCTION TO COMPUTER UTILITIES
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SLIDE-1: (cover slide) Introduction to Computer Utilities
This is the third class in the Digital Literacy FIRST STEPS course. This class covers two common utilities;
managing windows and using basic editing functions:
•
•
•

How to manage windows
Cut & Paste functions
Undo and Exit functions

NOTE: The term “window” applies to graphical borders, as opposed to Microsoft programs
The slide notes are organized in three ways:
•
•

Bolded words, or group of words, describe a bulleted item
General concepts applicable to a slide overall are provided for background information

•

Italicized information denotes particular emphasis, such as a critical concept

SLIDE-2: Prerequisites
The 1.1 Computer Systems class covered the basic concepts. The module described different categories
of computers, how to connect cables to a computer, how to power up a computer and log on and how
to power down the computer.
The next class, 1.2 Computer Desktops, showed students how to use a mouse and keyboard. Students
learned how to use toolbars and icons and how to personalize a desktop.
The tasks in these modules must be mastered prior to beginning Module 1.3 - Introduction to Computer
Utilities.
SLIDE-3: Agenda
In this module, the student will learn how to manipulate windows. When a program is opened, the
application appears on the desktop. The program is outlined by a graphical frame, referred to as a
window. This section describes how windows are managed. For example, windows can be resized, and
moved.
Common editing tasks are also covered. For example, the student will learn how to copy an item and
then place it into another location. They will also learn how to make copies of folders and files.
NOTE: Folders and Files are covered in the next class, 1.4 Electronic Folders and Files
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SLIDE-4: Managing Windows (transition slide)
Windows help users manage their desktop workspace and efficiently complete computing tasks. While
the concept of a window may seem unfamiliar at first, this feeling quickly dissipates as users practice
using windows.
Most programs open with a window that is the size of the desktop, which is considered full size.
Windows can also be reduced in size to only take up a small portion of the computer desktop.
This section goes into great detail regarding the manipulation of window sizes and also provides useful
techniques for managing various programs simultaneously.
SLIDE-5: Managing Windows
In the Computer Desktops class, students learned how to open a program by double-clicking on an icon
on the desktop, or by using the Start menu.
Any time a program is opened it displays as a window. Several program windows can be open at the
same time. For example, an email program can be open at the same time a document is being worked
on in a Word processing program.
SLIDE-6: Managing Windows – Layering
There are several options to organize multiple windows on the desktop. For example, this slide shows
several open windows. Not only can the user see them all, but they can quickly switch back and forth
between them.
SLIDE-7: Managing Windows – Changing Size with a Mouse
To make a window smaller than the full size, click on the Restore Down button in the upper right hand
corner of the window. Restore Down is the middle icon, which looks like two squares on top of each
other.
SLIDE-8: Managing Windows – Changing Size with a Mouse
A window can also be made into any size after it is reduced (Restore Down) by using the mouse pointer
and placing the cursor at the edge of an open window. The user must hold down the primary (left)
button when changing the size of the window and then release it when the window is at the desired
size.
SLIDE-9: Managing Windows – Changing Size with a Mouse
A window can be placed onto the Task Bar by using the Minimize function. The Minimize button is to the
left of the Restore Down button, and looks like a minus sign; the benefit of doing this is lessening the
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number of open windows. If too many windows are open at the same time, the desktop will look
cluttered and become more difficult to work with.
NOTE: To reverse the process, simply left-click (primary) the icon once and the window is opened and
placed back on the desktop in the same place from which it was previously minimized.
SLIDE-10: Managing Windows – Changing Size with a Mouse
To maximize a window to full size, click on the Maximize button. Maximize is the middle icon, which
looks like one square.
NOTE: The middle button changes depending on the state of the window size. For example, if the window
is full size, the middle icon has double squares. However, if the window has been reduced in size, the
middle button is a single square.
HANDS-ON: Have students Restore Down, Resize, Minimize and Maximize an open program.
SLIDE-11: Managing Windows – Changing Windows with a Keyboard
A user can alternately make a window smaller than the full size by using the keyboard. Restore Down on
a keyboard requires the use of two keys:
Press the Windows key and the Down Arrow key at the same time.
SLIDE-12: Managing Windows – Changing Windows with a Keyboard
A user can alternately place a program window in the Task Bar by using a keyboard. Minimize on a
keyboard requires the use of two keys:
Press the Windows key and the M key at the same time.
SLIDE-13: Managing Windows – Changing Windows with a Keyboard
A user can alternately make a window full size by using a keyboard. Maximize on a keyboard requires
the use of two keys:
Press the Windows key and the Up Arrow key at the same time.
HANDS-ON: Have students Restore Down, Minimize and Maximize an open program.
SLIDE-14: (transition slide) Cut, Copy, and Paste
In this section students learn some of the basic functions used by most programs. Cut, copy and paste
are commands that allow a user to transfer text, data, files or objects from a source to a destination.
This can occur within a document, between documents, between programs and within folders and files.
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NOTE: Inform the students that folder and file training is covered in the next class, Electronic Folders &
Files
SLIDE-15: Cut, Copy and Paste
NOTE: While most programs allow Cut, Copy and Paste, the training provides examples using Microsoft
Word.
It is important to understand the differences between Cut and Copy. The primary use of the CUT
feature is to remove selected text, data or an object and to place it somewhere else; for example, into a
separate document, program or application.
When text, data or an object is CUT, a copy is made and the item is removed from the source location.
When text, data or an object is COPIED, a copy is made, however, the copied item remains in the source
location.
PASTE takes the cut or copied text, data or object and places it in a desired new location(s). Once an
item is copied or cut, it can be pasted into multiple locations.
SLIDE-16: Cut, Copy and Paste – Selecting
There are several methods for selecting the text, data or object to be Cut or Copied. One method is to
use the mouse. If, for example, the user wishes to select a word, sentence or paragraph contained in a
Microsoft Word document, the cursor is positioned at the beginning of the target item, the primary
(left) mouse button is held down to anchor the start point and the cursor dragged to the end of the
target. The user then releases the primary (left) button. The target will then be highlighted as shown on
the slide. This allows the user to know exactly what data is going to be cut or copied.
An alternate method of selecting a target is to use the keyboard. For example, pressing the Control + A
keys simultaneously selects all text in a document. To select only a portion of the text, or a single word,
use the arrows keys. For example, position the cursor at the beginning of the target. Then press the
Control key while pressing the right arrow key until the end of the target is reached.
SLIDE-17: Cut – Using the Cut Soft Button
Once the target is selected, press the Cut button on the tool bar (as seen on the slide) to make a copy of
the target.
SLIDE-18: Cut – Using the Secondary Mouse Button
Once the target is selected, use the Cut function from menu brought up when the secondary (right)
button is depressed.
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SLIDE-19: Cut – Using a Keyboard
The keyboard may also be used to Cut a selected target. After highlighting the data to be Cut, hold
down the Ctrl key and depress the X key simultaneously.
SLIDE-20: Copy – Using the Copy Soft Button
Once the target is selected, press the Copy button on the tool bar (as seen on the slide) to make a copy
of the target.
SLIDE-21: Copy – Using the Secondary Button
Once the target is selected, use the Copy function from the menu brought up when the secondary
(right) button is depressed.
SLIDE-22: Copy – Using a Keyboard
The keyboard may also be used to Copy a selected target. After highlighting the data to be Copied, hold
down the Ctrl key and depress the C key simultaneously.
SLIDE-23: Paste – Using the Paste Soft Button
After the text, data or object has been Cut or Copied, it can be pasted to the desired location or
locations. Using the mouse, place your cursor in the location you want to Paste the selection. Then go to
the Home tab and select the Paste function. This will place the last Cut or Copied item into the
document at the selected location. This process can be repeated if the user wishes to paste the item
into multiple locations.
SLIDE-24: Paste – Using the Secondary Button
Once the target area is selected, use the Paste function from the menu brought up when the secondary
(right) button is depressed.
NOTE: Explain there is more than one type of Paste. The example shown on the slide is a simple text
Paste. When other programs are used, different types of Paste functions exist and selection of which type
to use is based on user preference, however, such instruction is beyond the scope of the training.
SLIDE-25: Paste – Using a Keyboard
The keyboard may also be used to Paste a selected target. After the target area is selected, hold down
the Ctrl key and depress the V key simultaneously.
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SLIDE-26: Cut, Copy and Paste – Clipboard
The Clipboard is a feature Windows provides to temporarily store information for easy retrieval and
allows users to Cut or Copy several pieces of data and save them to the Clipboard. A major benefit of
Clipboard is that users are not limited to only the last data copied.
NOTE-1: Point out that Copy and Cut only hold the information until either is used again.
NOTE-2: Up to 24 items, which were previously Cut or Copied, can be stored onto the Clipboard. After the
24th item, the oldest Cut or Copied item is removed.
The Clipboard is accessed from a side-bar menu, which means it is visible on the left inside portion of
the program window. Clipboard looks similar to the menus found after clicking the primary (left) mouse
button. The Clipboard is either hidden, which is the default mode, or is made visible with minimal effort
on the part of the user.
The purpose of the Clipboard is two-fold:
•
•

To keep what is Cut or Copied in one convenient area.
To Paste items by using the sub drop-down menu next to the information.

NOTE-3: The sub drop-down menu allows users to delete text or images.
SLIDE-27: Paste – Using the Clipboard Menu
To open the Clipboard, move the cursor to the Home tab and locate the Clipboard menu (all the way to
the left). When the cursor is placed over the icon in the lower right corner of that menu box, a small
arrow pointing down at an angle will appear. Left-click (primary) on the arrow and the Clipboard opens.
This slide displays an example of the Clipboard Pane with data previously copied onto it. There are
several options available from this location:
•
•

The soft button at the top of Clipboard menu (upper left) permits a user to Paste All, which
places everything into the working area of the program.
The user can also select any single line of text to Paste into a program working area. The user
can also clear any or all of the items if they are no longer needed. The user can also delete one
item at a time.

HANDS-ON: Allow the student to practice Cut, Copy and Paste using the previously described methods.
SLIDE-28: Undo, Redo and Exit (transition slide)
Undo is a tool that allows the user to erase the last change or changes made to a document. For
example, if the user accidentally deletes desired text, data or an object, they can press the undo button
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to restore it. It is important to know that this function works within a document and most other
programs. However, Undo cannot be used to restore an entire document if accidentally deleted.
Redo allows the user to reverse an undo.
Lastly, when the user finishes with a program, the user closes it by using Exit.
NOTE-1: Make sure work is saved before exiting the program, otherwise the work done during the
session is lost.
SLIDE-29: Undo – Using a Toolbar Soft button
To perform an Undo, use the small icon in the upper left hand corner that resembles an arrow pointing
back, or use the keyboard, which is covered on the next slide.
SLIDE-30: Undo – Using a Keyboard
The keyboard command for an undo is to hold down the Ctrl key and press the Z key at the same time.
SLIDE-31: Redo – Using a Toolbar Soft button
To perform a Redo, use the small icon in the upper left hand corner that resembles a partial circle with
the arrow pointing counter-clockwise. This is next to the Undo arrow.
SLIDE-32: Redo – Using a keyboard
The keyboard command for a Redo is to hold down the Ctrl key and press the Y key at the same time.
SLIDE-33: Exit
To Exit, select the File tab in the upper left corner. That will display a drop down menu with an Exit
button at the bottom. Clicking on the button will close a program. The user will be prompted to save
their work if changes have been made since the last time the document was saved.
A program can also be closed by clicking the X on the upper right corner of the window.
SLIDE-34: Exit – What to do with Completed Work
This is a picture of the Save prompt. It is seen when closing a document and or Exiting a program. If
Save is selected, with the mouse pointer single-click (primary) and the computer will save any changes
made to the document. If Don’t Save is selected, the program will close without saving the recently
completed work.
Cancel will stop the close document or Exit function.
NOTE: Explain this feature is explained in detail in the next section, but was put here for completeness.
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SLIDE-35: Exit – Using a Keyboard
The user can also Exit a program by using the keyboard. This is done by holding the Alt key while
pressing the F4 key. If changes since the last save have been made, the computer will bring up the Save
prompt.
HANDS-ON: Allow the student to practice the undo, redo and exit/save functions
SLIDE-36: Recommended Next Steps
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